
 EarthLink WebSpace
EarthLink WebSpace is a tool that makes it easy for you to see the files stored in your WebSpace on an EarthLink computer and 

to update those files by copying them from your computer.    You can also use WebSpace access files on any FTP site and you 
can manage a list of FTP sites you regularly visit.
Changing your View of the Folders and Files 
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Synchronizing Files 
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Using the WebSpace Toolbar 

For more information about EarthLink 5.0, see   EarthLink Help  . 



 Launching EarthLink WebSpace
To launch WebSpace:
 Click the WebSpace button on the EarthLink Browser toolbar.
The EarthLink WebSpace window opens.    This window shows the files stored on your computer and in your WebSpace on the 
EarthLink computer.    You can drag and drop files from one side of the screen to the other, thereby copying files from your 
computer to the EarthLink computer and vice versa.



 Using the WebSpace Toolbar

 Click Connect to open the FTP Site Manager for connecting to other FTP sites.
 Click New Folder to create a new folder on the currently selected drive, whether that’s the drive on your computer or from your 

WebSpace on the EarthLink computer.
 Click Delete to delete the highlighted file(s) or folder(s) on either your computer or from your WebSpace on the EarthLink 

computer.
 Click Stop to cancel the current operation (except uploads or downloads). (Use the Cancel button on the progress dialog to 

cancel an upload or download.) 
 Click Refresh to reload the list of files on either your computer or in your WebSpace. 
 Click Properties to see the properties for the selected file.    This includes the file name, type, directory location, size and the date

and time last modified. 
 Click Find to search for a file either on your computer or in your WebSpace on the EarthLink computer. 



 Connecting to EarthLink
If you’re not already connected when you start WebSpace you will not be able to see the files in your WebSpace on the 
EarthLink computer.    This requires an active connection.    If EarthLink does not automatically connect you when you open 
WebSpace, click Sign On on the EarthLink toolbar.



 Creating a New Folder
You may want to create a folder just for storing your WebSpace files, or to keep an archive of a previous version.
 Select the computer you want to create the new folder on.
 Select the drive and/or folder that will contain the new folder.
 Select New Folder from the File menu.



 Deleting a File
You may want to delete files that are no longer in use.
 Right click on the file that you want to remove, then select Delete from the menu.
 Click Yes to confirm this deletion.



 Renaming a File
You may want to rename a file so you can copy a newer version of the file without overwriting the old.
 Right click on the file you want to rename, then select Rename. From the menu.
 Type the new name for the file, including the desired extension, if any.



 Finding a File
You may want to locate a file on a drive.
 Click Find on the toolbar to open the Find Files dialg.
 Enter the name of the file you want to find then click Find Now.    
You can use wild cards when looking for a file.    For example, to find all files with a .jpg extension, enter *.jpg; to find all text files 
that start with cap, enter cap*.txt.



 Stopping the Current File Operation
If you realize that you did not select the correct files for upload or download, you can click Cancel to abort the file operation.



 Refreshing the Screen
When you open WebSpace, as with other programs that show the files and folders on your computer, the view you see is a 
image of the files and folders as they were at that moment.    If you have moved some files around or saved new files in another 
program since you opened WebSpace, the list of files and folders you see may be outdated.
To update the file and folder list:
 Select Refresh from the Window menu.



 Viewing Properties for a File
If there are files on your computer with similar names, or files with the same name in different folders, you may want to view the 
properties for a file to determine which is the most current.
To view properties for a file:
 Highlight the filename, click the right mouse button, and select Properties.



 Changing your View of the Folders and Files
You can view the files and folders as small icons, as a list of files, or as a list of files with details.
To change how you view the files on the current drive:
 Click the down arrow to the right of the View button on the WebSpace toolbar.
 Select the desired option from the list: Small Icons, List, or Details



 Uploading files to your Website
If you’ve made changes to any of the pages for your Website, you can upload them to your WebSpace.
To upload files to your WebSpace:
 In the Web Drive list, select the folder you want to copy your file(s) into.
 In the Local Drive list, select the folder containing the file(s) you want to upload.
 Select the file(s) or folder you want to upload to your Website from the Local Drive and drag them to the Web Drive 

or click 

.
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 Downloading files from your Website
If you haven’t updated your WebSpace recently, you may want to download the pages of your web site so you can modify them.
To download files from your WebSpace:
 In the Local Drive list, select the folder you want to copy your file(s) into.
 In the Web Drive list, select the folder containing the file(s) you want to upload.
 Select the file(s) or folder you want to download from your Website on the Web Drive and drag them to the Local Drive 

or click 
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 Synchronizing Files
If you keep a copy of your entire WebSpace on your computer, you can synchronize the files in both locations.    This will ensure 
that you have the most recent version of each file on both drives.
To synchronize the files on your computer with your WebSpace:
 In the Local Drive list, select the folder you want to synchronize.
 In the Web Drive list, select the folder you want to synchronize.
 Click 

How do I copy files from my computer to my Website? 
How do I copy files from my Website to my computer? 



 Adding a New Folder to an FTP Site
To add a new folder for folder:
 On the FTP Site Manager dialog, click New Folder.

FTP Site Manager adds a new folder to the FTP Site Profiles tree.
 Enter a name for the new folder.



 Adding New FTP Site
To add a new site:
 On the FTP Site Manager dialog, select the folder you want to add the new site to.
 Click New Site. 
 Enter a name and the FTP Site Address.    Optionally complete the rest of the fields.
Connecting to an FTP Site 



 Deleting an FTP Site or Folder
To delete an FTP Site or folder from the profiles list:
 On the FTP Site Manager dialog, highlight the site or folder you want to delete, then click Delete.



 Connecting to an FTP Site
To connect to a FTP Site in the profiles list:
 Select the site and click Connect.



Delete removes the current folder or file.



Find opens the Find Files dialog so you can search for files on a specified drive.



New Folder adds a new folder to the selected folder on the current drive.    You can immediately rename this folder.



Properties shows the File Type, Location, Size and Last Modification date for the selected file.



Refresh reloads the current directory.



Rename enables you to rename the selected file or folder.



Stop stops the current file transfer.



Views - Click the down arrow to select one of the following views: Large Icons, Small Icons, List, Details, Advanced



Closes the Site Manager window.



FTP Address – The address of the FTP site as you would normally type it in.



Upload - Clicking this button copies the selected files from your computer to the selected folder on the Web drive.



FTP Name – The name for this FTP site as you would like it to appear in your FTP Site folder.



File List -The files located on the selected drive (on your computer or on the Web server).



Drives lists the drives available on your computer or on the Web server.



Clicking Download copies the selected files from the Webdrive to the current folder and drive on your computer.



Clicking Synchronize opens the Synchronize Folder dialog so you can set synchronization preferences.    Synchronize 
compares the files in the current folder on the Web drive with the current folder on your computer and copies files from 
one to the other so both drives contain the same files and the same file version (by time and date stamp).



Animate Download shows animation while the download is “In progress”



Progress shows the progress of the file copy.



FTP Site – The address of the FTP site.    For example, your website at EarthLink can be found at ftp-www.earthlink.net.



Copy From enables you to select or specify the directory you want to copy files from.



User ID - Enter your user ID for this FTP Site.



Copy To enables you to select or specify the directory you want to copy file to.



Default Directory shows the default directory for the site.



Time Left shows the time remaining to complete the current copy operation.



Check Anonymous Login if you want to log into this site anonymously.



Bytes Copied shows the number of bytes that have been copied thus far for the current file.



Time Remaining shows the time remaining for all files.



Save Password - Check this box to save your password for this site.



New Site - Click this button to add a new site.



Bytes Copied – All Files Shows the number of bytes copied for all files.



Delete deletes the current selection.



Destination shows the Destination file name.



Password - Enter your password to access this FTP Site.



File Type shows the type of file, such as Word document.



Location shows the directory location of the file.



Name - Enter the name of the file you want to locate.



Date shows the date the file was last modified.



Site Tree shows the folders for the current FTP Site



Site Name shows the name for the current FTP Site.



Site Description shows the description of the current FTP Site.



Tree Shows the Site tree.



Drive Description identifies the current drive on your computer or on the Web server.



Update Local Folder - Check this option to update the folder on your computer with the contents of the like-named 
folder on the website.



Update Remote Folder - Check this option to update the folder on the website with the contents of the like-named folder
on your computer.



Include Subfolders - Check this option to include the subfolders in the synchronization process.



Don’t Delete - Check this option if you do not want to delete any files.



Confirm Deletions - Check this option to prompt you for confirmation before deleting files.



Confirm Overwrite - Check this option to prompt you for confirmation before overwriting files.



Include Subfolders - Check this option if you want to include the subfolders in your search.



Find Directory – Shows the directory you are searching.



Source Title shows the title of the source folder.



Source shows the source file name.



Destination Title shows the title of the destination folder.



File Size shows the size of the selected file.



Transfer Rate shows the number of bytes being transferred/minute or second.



Time Remaining to complete the tranfer.



Total Transferred- the total number of bytes that has already been transferred.



Select Site Manager to open the FTP Site Manager for connecting to other FTP sites.



Click No to All if you don’t want to overwrite any files.    Only files in the selection group that do not exist on the 
destination drive will be copied.



Click Yes to All if you want to overwrite all files in the destination drive with files of the same name in the selection 
group.



FTP Tree – shows the folders available.



Click Change Password if you need to change your password.



Check Anonymous Login if you want to log in anonymously.



Click New Folder to create a new folder within the selected folder.



Enter your User Name.



 Drives on Your Computer
The left side of the WebSpace window shows the drives on your computer and the folders and files on the currently selected 
drive.    
To view the folders and files on another drive on your computer, select the drive letter from the Drives List. 
Uploading Files to your WebSpace 
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 Drives on the Web Server
The right side of the WebSpace window shows the drives on the Web server.    If you are uploading files to your WebSpace, you 
will typically see only one drive listed.    There may be one or more folders shown for that drive.    Any pages you created using 
Click-n-Build will be in this list.
Uploading Files to your WebSpace 
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 File Properties
Shows the type of file, directory location, file size, and the date it was last modified.



 Synchronize Folders
Provides options for synchronizing folder contents.
If you want to update only the files on the remote computer, such as the files in your website on the EarthLink computer, check 
Update Remote Folder.
If you want to update only the files on your computer, check Update Local Folder.
If you want to have the most recent files in both locations, check Update Remote Folder and Update Local Folder. 
If you use subfolder, be sure to check Include Sub-Folders.
If you want a bit more control of the update, check Confirm Overwrites so you can verify and accept each overwrite.



 Find Files
Enables you to find files on your computer or on the Web site.    The search will begin from the current folder (directory), so be 
sure you select either a specific folder on your computer, or your WebSpace on the EarthLink computer before you click Find.      
To locate a specific file:
 Enter the name of the file in the Named field.    You can use wildcards.    

If you want the search to include subdirectories of the current folder, check Include Sub Folders. 
 Click Find Now.    Files matching your criteria appear in the list with the name of the folder they reside in.



 FTP Site Manager
Site Manager provides a set of tools for managing the information on your Website.
The left side of the dialog lists your favorite FTP Sites.    By default the only site listed initially is your EarthLink webspace (where 
your web site lives).    
The right side of the dialog shows the details for the selected site.    
Adding a New Folder to an FTP Site 
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 Directory Menu
Download 
Upload 
Synchronize Folders 
Properties 
Create Folder
Delete 
Rename 



 WebSpace Menu
Connect 
Create New Folder
Delete 
Refresh 
Stop 
Properties 
Find 



 Sign Up for your Webspace
You haven’t signed up for your own slice of the World Wide Web.    Your EarthLink Sprint account includes a chunk of real estate 
on the Internet for your home page.    Sign up to use that space here.    Then visit the EarthLink website to find out how to use 
Click-n-Build to create your home page.



 Overwrite?
The file already exists on the destination drive.    
Click Yes if you want to overwrite this file. You will be prompted to overwrite other files in selection group one-by-one as 
necessary.
Click Yes to All if you want to overwrite all files in the destination drive with files of the same name in the selection group.
Click No if you do NOT want to overwrite this file.    This file will be skipped and you will be prompted to overwrite other files in the
selection group one-by-one as necessary.
Click No to All if you don’t want to overwrite any files.    Only files in the selection group that do not exist on the destination drive 
will be copied.



 WebSpace Login Failed
WebSpace was unable to connect to the specified web site with the User ID and password you supplied.    Check your entries 
and try to connect again.    If you still cannot connect using your User ID and password try to connect using anonymous login.    If 
you are able to connect using anonymous login, there is a problem with your User ID and password.    Check with the site’s 
webmaster.



 Browse for Folder
This dialog lists the available folders.    Select the folder you want to move or copy the selected item into, then click OK.
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You are low on system resources
Your system may not behave as expected while in this condition.    To remedy the low on resources condition, close any 
extraneous EarthLink 5.0 windows or other programs that are currently running on your computer that you are not currently 
using.    To close EarthLink 5.0 windows you are no longer using, click on the Window menu and select the name of the window 
you want to close, then either double-click on the icon to the left of the File menu, or select Close from the File menu.    Repeat 
this process until you have closed all extraneous windows.
Note: If you have a number of icons in your System Tray, these also impact system resources.    If you consistently get “low on 
resources” messages, you should consider closing a number of these programs. To close a program in your System Tray, right 
click on the icon and click Close or Exit.



You are no longer connected to the Internet
You will not be able to send or receive email, upload or download files, or view web sites online unless you are connected to the 
Internet. Click Yes to connect to the Internet now.    Click No to continue working offline.




